
Macaholics UNANIMOUS Page 1

                   March 2013  Volume 21  Issue 04The Official Newsletter of the Upper Keys Macintosh Users Group

OUR NEXT MEETING: 

Thursday, 
r March 14, 2013 r

7pm at Key Largo Library 
Community Room  

MM 101.4 Oceanside

“How I Learned to Love the Cloud” 
An Intro to iCloud Services

by Joe Kukella

Joe is one of our favorite speakers, 
and he’s coming up from Key West!

Sweet Tips             
and Tricks 

by Sue Beal

Our February meeting fell on 
Valentine’s Day this year, and we 
didn’t know how many of  you 
would forgo the usual celebra-
tions to come out for Tips and 
Tricks. Turns out, many of  you 
love your Macs enough to spend 
Valentines Day with them — we 
had 40 people!

There were lots of  good tips, and 
I took copious notes... so those of  

continued on page two

The new way: side by side listing and detail.

The Classic way: listings at top and detail at bottom.

Our speakers for Sweetheart Tips and Tricks: Diane Mar-
shall, John Hammerstrom and Karen Beal. 

you who didn’t catch every detail (or had 
to miss it) can read all about it here.
Mail Tips

Karen kicked it off  with Tips and Tricks 
for Mail. Be aware: this is Apple’s Mail 
program, not your online provider like 
gmail. “Small changes in how you set up 
Mail can make a big difference in how Mail 
works for you,” says Karen.

For example, in the more recent versions 
of  the operating system, Apple made the 

Mail interface look like it does on a hand-
held device; it uses a side by side listing 
format. Not everyone loves this. If  you 
want it to look like it used to (see examples 
below) then do this:

Open Mail and go under the menu that 
says “Mail” (at the top, next to the Apple 
menu). Select Preferences, and the Viewing 
tab. At the top you can check a box that says 
“Use Classic Layout.” That’s all it takes!

Another Mail tip Karen gave us was 
that you can have Mail high-
light emails that relate to the 
conversational thread of  the one 
you’re currently viewing. There’s 
a preference for View Conversa-
tions. Check that, and you can 
even pick a highlight color. Then 
when you click on one of  those 
emails where you have been going 
back and forth with someone (or 
a group of  someones) on a certain 
topic - all of  them highlight in the 
chosen color to help you see your 
way back through it. Click off  
the email and the highlights go 
away, or light up the new thread 
you clicked on.
Adding Photos to Emails

There are a couple ways to put 
a photo into an email: You can 
drag it and drop it in, you can 
click the “attach” button in the 

iCloud is a free, cloud-based storage 
and computing service that can store 
all of  your music, photos, calendars, 
contacts, etc. and wirelessly push them 
to your i-devices. Joe will provide an 
overview of  iCloud, detail how to get 
your data into the cloud, and discuss 
why this cloud has a silver lining. He’ll 
also talk about some non-Apple cloud-
based services such as Google Docs 
and Dropbox.

While he is in the Upper Keys on 
Thursday the 14th, Joe will be booking 
appointments for personal training 
visits. If  you’re interested in having 
him stop by your home or business for 
an hour or so to cover any Mac OS, iOS 
(iPhone and iPad), or Adobe product 
(Creative Suite, Photoshop, Illustrator, 
InDesign) questions you have, drop him 
a note at joe@kukella.com and he’ll get 
back to you. He can also add you to his 
mailing list so you get advance notice 
on his future visits to the Upper Keys!

A Mac user since 1988, Joe’s work 
as a designer and educator gives him 
a unique perspective on technology, 
how people use it, and how to explain 
it to others. He’s an Assistant Online 
Program Director for the Graphic and 
Web Design Dept. at Art Institute of  
Pittsburgh’s Online Division, and he 
hosts workshops and training services 
in Key West focused on Macs, iPhones, 
and iPads for individuals and small 
groups. He spent five years with Ma-
cintosh Systems Solutions serving as 
the Service and Education Coordinator. 
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Sweet Tips and Tricks
continued from page one

IT’S DUES TIME
It’s dues time again! $25 per year is our 

requested and voluntary donation... to keep 
UKMUG running smoothly. We ask for 
dues in Jan-Feb-Mar.

Please send a check payable to UKMUG 
at 219 2nd St., Key Largo, FL 33037 or 
hand it to Sue or John Thomas at the next 
meeting. Thank you to the ones who already 
paid,    and to those who live far away and still 
support the club. You’re especially appreci-
ated!

Harold Pinder once asked me, “What 
do I get for my dues?” I answered that pay-           
ing dues gets you nothing you can’t already 
get for free! Then he asked, “What does 
the group get for my dues?” What a great 
question! 

With your dues, UKMUG:
-  purchases and maintains equipment 
 for our presentations
-  pays the hosting fee for our website
-  provides refreshments at the meetings
-  donates to the Library for the room
-  puts ads in the papers occasionally to 
 draw in new people
-  pays for duplicating the newsletter and 
 flyers to advertise meetings
-  purchases the occasional movie or 
 software for demonstration or raffle
-  purchases some of  our holiday gifts

So I guess the short answer is, with your 
support, we can keep everything going and 
provide a better experience for all.

continued on page three

Videography 
Request

John Cain prompts me 
to ask if  anyone has the 
capability to record our 
meetings on video - then 
post the presentations on 

the web for those out of  town or unable to 
attend. I think it’s a great idea! Does anyone 
have that capability... who is available and 
willing to do this for us? Call or email Sue. 
451-4601 or ukmug@bellsouth.net.

Can You Help?

bottom of  the Mail window frame, or you 
can use the Photo Browser button on the 
upper right (see above).

When you click the Photo Browser but-
ton, it gives you a window into your iPhoto 
library to let you chose the photo or photos 
you want to put into the email.

Sometimes the photos we have to send are 
too big and overwhelm our outgoing email 
system as well as the recipient. There’s an 
easy fix for that.

Once you’ve added photos to an email, 
you see a button on the lower right part of  
the Mail window. Click this for a menu that 
allows you to resize your outgoing photos 
on the fly. Very handy! Just remember - 
when you set this, it stays set that way, so 
it will affect all future email attachments 
until you change it.
Searching in Mail

Karen showed us two ways to search our 
email: First, there’s a search bubble in the 
upper right corner of  the Mail window.

You can see here that as she began to type, 
a pop-down menu started to fill in with the 
subjects of emails that matched her search 
for “ramble.” There’s even a way to search 
the attachments at the bottom of it.

Or you can just look in the main window 
and see everything that matches “ramble.” 
You can narrow the search to just one 
mailbox, or all; and you can search just the 

Left: The Photo 
Browser button is 
shown circled in the 
upper right of  the 
Mail window. If  you 
don’t see that button, 
pull down Mail’s 
“Window” menu and 
select Photo Browser.

subject line, the entire message, the “To” or 
the “From” fields. Very useful when you 
know Joe sent it to you but you have no 
idea when or what he called it.

The second way to search in Mail is 
with Spotlight, which is that menu in the 
far upper right of  your Finder Menu - the 
icon looks like a magnifying glass.
Make Life Easier

Did you know that there are programs on 
the internet that scrub emails for live email 
addresses? Then the addresses are sold to 
spammers and scammers!

So be discrete when sending an email to 
more than a few people. Use the “BCC” file 
instead of  the “To” or “CC” for inputting all 
those addresses. That hides them from the 
other recipients. CC stands for Carbon Copy 
and BCC for Blind Carbon Copy, and the 
use of  these terms dates back to secretaries 
and typewriters. Even though it’s antiquated 
terminology, the concept is still the same. 
Anyone you put into the TO or CC field is 
copied in, and the other recipients can see 
it. If  you put them in BCC, no one knows 
they got it except them. Simple!

You might not see a BCC field in your Mail 
window. Click the “New Message” button 
and look at the window that comes up.

If you don’t see BCC or CC, use the button 
circled here to make it appear. That does it for 
this email. If  you want it always and forever, 
click the Customize item on that menu and 
set it for good. The recipients of a BCC just 
see “undisclosed recipients” in there.

Some people take CC off, since you can 



Macaholics UNANIMOUS Page 3

  Carpool 
  Request

Anyone coming past Executive 
Bay Club to come to UKMUG? Ken 
Morley would love to hitch a ride; he 
can’t drive that far at night any more.

Email Ken at kmorley480@sbcglob-
al.net or call 852-7843 if  you can help!

Sweet Tips & Tricks
continued from page two

continued on page four

just put everyone you want to have known 
publicly in the TO field.
Be Courteous

When you forward an email, take a few 
seconds and delete all the other people it 
went through to get to you, in the body of  
the email. Don’t perpetuate the bad man-
ners they had when they sent it to you with 
so many names and addresses on it!
Smart Mailbox

A Smart Mailbox can be set up to catch 
all emails from a certain person, or on a 
selected subject. Here’s one way to do it for 
a certain person: click in one of  the emails, 
on the bubble with their name. You’ll see a 
little triangle on the right side of  the bubble. 
Click and hold and a menu will pop down. 
Select “Create Smart Mailbox.” Another 
way is to go to the Mailbox menu and chose 
New > Smart Mailbox.

However you get there, give the new 
Mailbox a name and fine tune the rules 
to catch what you want.

The emails collected will be in the Smart 
Mailbox AND in the regular email. The 
Smart Mailbox is just a quick way to collect 
them in one place.

Make a Smart Mailbox for texts from a grandkid.

xxxxxxxx

Send Texts from Mail

If  everyone around you is texting but 
you’re at a desktop Mac, you can still send 
text messages. (But you can’t send pictures 
via text message). All you need to do is 
figure out the person’s text address. It’s their 
phone number “at” their phone provider 
domain. Something like 3054514601@txt.
att.net. (Don’t try that one, it’s not valid!) 
But you get the idea. Every phone provider 
has a unique domain, and once you get 
that you’re good to go.
Just for Fun: Stationery 
& Signatures

It’s easy to add a cus-
tom look to your emails, 
Apple built in these two 
functions for you!

Click the Stationery 
icon in the upper right 
of  the New Message 
window, and see what ap-
pears in the center of  that window. Down 
the left you’ll see a list of  themes, and when 
you click on one of  those, you get choices 
across the window. Click on any of  the little 
pictures there to use that choice.

Or you can customize it and make it your 
own. You can pick a theme and then use 
the photo browser to put your own images  
into it. Click on the text placeholder that’s 
there and type in what you’d like to say. 
This works just like Pages when you start 
with a template.

You can also create something you like 
in Pages and then use the File Menu>Save 
a Stationery to make your very own look.

Or, you can go online and get Stationery 
templates - for fee or for free. Look around.

When you click on the little Stationery icon, an 
area appears in the center of  the email window to 
let you choose what stationery to use, by theme.

http://www.equinux.com - one of  the many 
sites that sell Mail Stationery online.

Signatures

A Signature is put at then end of  every 
email automatically for you. You can 
use your photo, your actual signature as 
a graphic, contact info, a great quote, an 
animation... whatever you want.

Pull down the menu next to the word 
“Signature” (see figure below)  to see your 
options. It’s easy!

You can set up multiple signatures — 
maybe one for business and one for fun... 
whatever you need. Create a new one by 
hitting the plus sign. Drag in graphics, add 
text, make it your own. You can have differ-
ent ones for different email addresses too.

 

From TED: Interesting thing to do 
with your iPhone:

http://www.ted.com/talks/cesar_kuri-
yama_one_second_every_day.html?utm_
source=news le t t e r_week ly_2013 -02 -
09&utm_campaign=newsletter_weekly&utm_
medium=email
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continued on page five

Sweet Tips and Tricks
continued from page three

Controlled Screen Shots

Every one knows you can hit 3 keys 
simultaneously and take a picture of  
your screen (Shift-command-3). But did 
you know you can focus in on just the 
part you want? That’s called a controlled 
screen shot. Hit shift-command-4 then use 
your cursor to drag a box around what 
you want to capture. Drag, release, click! 
You’ll hear a camera shutter sound effect, 
and on your desktop you’ll see a document 
appear called Screen Shot followed by a 
time/date stamp. You can open this with 
Preview, edit it in Photoshop, or drop it 
into an email -- whatever you’d normally 
do with a picture file. Feel free to name it 
something more descriptive. This is very 
handy when you see something on a web 
page you want to share but can’t grab it 
without clicking through to something else. 

Karen used this technique to capture 
all the screen images she showed in her 
slideshow, then she added the red circles 
in Keynote. Very nice!
Taking from the Web

Here’s a great tip for getting better images 
when you take a screen shot on the web...  
use command+ (plus sign) to make the im-
age bigger and bigger... when you have it as 
big as possible, then take the screen shot.

Keep in mind, if  they put a poor quality 
picture out there, it will still look poor when 
you zoom in. But a lot of  times you’ll see 
it gets bigger and better.

Use command- (minus sign) to back away 
after your close-up view, or command-0 
(zero) to reset it to normal in one step.

Another way to grab an image from a 
website it to just click on it and drag it to 
your desktop. It doesn’t always work (if  
not, use the procedure above).
Customize the Desktop

Karen likes to keep a folder of  cool 
images she finds on the web and then use 
them in her desktop background. Name the 
folder and put it in your Documents folder, 
then go to System Preferences > Desktop 
& Screen Saver > Desktop and navigate to 
bring that folder in as the source of  your 
desktop photos.
“Most Recent” from the Dock

Click and hold on any application icon in 
your dock to have  menu pop up showing 
the most recent documents you worked on 
with that app.

Make a New Folder with Selected Items

This was one I didn’t know! Sure, I knew 
how to make a new folder (shift-command-
N or File Menu>New Folder). Then you 
carefully select the type and change the 
name to something descriptive... then pick 
up each document you want in there, drag 
it and drop it in. We’ve been doing that the 
same way since 1984.

But now it’s streamlined: Use command 
click to highlight several documents you 
want to put into a new folder. Then go to 
File>New Folder With Selection and boom! 
they’re already in there! Give it a name 
(it’s already highlighted and ready for you 
to type) and you’re good to go. (This is a 
new feature with Lion/Mountain Lion... 
doesn’t work in older versions.)
Contextual Menus

You have to try this - it’s so cool! Any 
time you have something highlighted, say, 
a document on your desktop, try Control-
clicking it.

A menu will pop up right there where 
the cursor is, showing all the things you 
might like to do with it. No mousing up 
to the menu or trying to remember key 
commands. Just Control-click!
Noodle Around with Spotlight

Spotlight is the magnifying glass icon 
in the upper right corner of  your Finder 
Menu bar. Click on it to start searching your 
computer for anything you need to find. As 
you type each letter it refines the search.

Can’t find an app? Open Spotlight, start 
typing its name and as soon as you see it, 
click on the name tin Spotlight’s results - it 
will open!

Spotlight also has a web-based search 
option. Try it, it’s fast.
John’s Presentation

John’s tips were less OSX and more iOS6 
and web related... but there were lots of  
good ones all the same!
Do Not Disturb vs. Airplane Mode

On your iOS6 device, 
these are in Settings... but 
what’s the difference?

Airplane Mode means 
nothing can be transmitted 
or received by phone with no exceptions. 
Do Not Disturb will allow you to receive 
phone calls from your Favorites list, or a 
repeat call within three minutes. So basi-
cally, Do Not Disturb is Airplane Mode 
with auto or user-defined exceptions.

Spotlight’s web search option.

Screen Shot on iPhone or iPad or Touch

Did you know you can capture a screen 
shot on your iPad, iPhone or iPod Touch? 
This allows you create a picture of  anything 
displayed on the screen, no matter which 
App you have open. Just press and hold 
the menu button (the main button below 
the screen), and while the menu button is 
held down, press the power/lock button 
(the switch on the top edge of  the device).

   You can also hold the lock button and 
press the menu button, or try to press the 
two buttons simultaneously. Do whatever 
is easiest, but if  you keep both buttons 
held down too long, you will get the power 
down confirmation.

Your screen will flash white for a second 
and make a camera shutter noise to indicate 
that the screen shot has been taken. The 
screen shots you take are automatically 
saved in the default Photos App under an 
album called “Saved Photos” or “Camera 
Roll” depending on your device.
Add Images to an Email Faster

It can be a little cumbersome to go 
through the Photo app to add a photo to 
an email on your i-Device. Try this:
•	 Start	composing	the	email	in	Mail
•	 Tap	on	email	and	hold	until	you	 see	

“Select, Select All, Paste”
•	 Tap	the	triangle	to	the	right.
•	 Tap	Insert	Photo	or	Video
•	 Select	the	image	you	want
John credits www.macgasm.net for this tip.
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Sweet Tips and Tricks
continued from page four

continued on page six

John shows AllMyFaves.com

Threads on stumbleupon.com

ALL MY FAVES

John calls this the mother of  all websites. 
One website from which to jump off  to just 
about anywhere you want to go. It’s called 
www.allmyfaves.com. See the picture at 
the right to get an idea of  what looks like.
Explore the Internet Serendipitously

www.stumbleupon.com. Later, Diane 
will show how to look up “serendipitously!” 
Seriously, once you get into Stumble Upon, 
you can identify threads you want to follow.
Bring Back the Scroll Bars!

In one of  the recent OSX system up-
grades, Apple made the scroll bars go away, 
except for every once in a while (!). If  you 
miss them, here’s how to bring them back: 
System Preferences>General>Show Scroll 
Bars>ALWAYS.
Enable Emoji Keyboard

What’s an Emjoji? Emjoies are those 
cute little faces that grew from Emoticons.

To enable, on your i-Device... Settings> 
General>Keyboard/Keyboards>Add 
New Keyboard>Emoji.

Your Keyboard will show a little “earth” 
icon like this...

Tap that to see your Emoji choices. Tap 
your choice and it gets inserted into your 
email.

Typing Shortcuts

You can create custom shortcuts in iOS6 
for words or phrases you type frequently: 
Settings>General>Keyboard>Add New 
Shortcut.

Now instead of  typing out “on my way” 
you can just type omw and it will fill it in 
automatically. Noodle around - there are 
other options you can use on that Settings 
screen.
Get a Human - Customer Support

John says, “Caught in a phone-tree maze, 
dealing with unfeeling robots at Apple Sup-
port? Want to talk to a human?”

Drop an “F Bomb!” That’s right. Many 
voice recognition systems are programmed 
to recognize that swearing indicates frus-
tration and they will escalate your call. 
Who knew?

Macgasm.net adds “Use at your own 
risk. May work with other Interactive Voice 
Response systems.”
Diane’s Presentation

Diane did a live lecture demonstration 
(as opposed to a Keynote presentation). 
She showed...
Calculator

Who knew there was so much to this? 
First of  all, you might not even know where 

Ike Beal and Mary Anne Roper enjoy the 
Valentines-themed refreshments table.

it is, but you have it. Go to the Applications 
folder, find it and drag it to your Dock so 
you know where to find it in the future.

Open the App. There are 3 different kinds 
of  calculators: Select the View menu and 
choose Scientific. (Or press Command-2.)

To return to the Basic calculator, choose 
it from the menu or press Command-1. 
There is also a Programmer mode (Com-
mand-3) that calculates in binary, ascii, 
unicode and more. But if  you need that 
one, you probably already knew about it!

Converter

The Calculator also does conversions! 
This is handy: convert currency, measure-
ments, temperature, etc. Say you’re on a 
website that offers a price in British pounds 
or say it gives the temperature in Celsius. 

--Open the Calculator.
-- Enter the number.
-- Go to the 
   Convert pull-
   down menu.
--And select 
   Currency or 
   Temperature.

And there’s more!

Your calculator 
talks and writes. 
If  you’re entering 
a lot of  numbers and you want to make 
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sure you get them right, you can do the 
following two things:  show the paper tape 
and enable speech.

-- Under the Speech menu choose Speak 
Button Pressed. A check mark appears.

-- Under the Speech menu you can also 
press Speak Result, although Diane 
says that it doesn’t always work.

-- Under the Window menu choose Show 
Paper Tape and a separate window 
opens. You can print or save the paper 
tape as well. Since it’s a separate win-
dow, it runs in the background when 
you have calculator open, unless you 
choose not to display it.

Dictionary and Spelling

Again, find the Dictionary App in the 
Applications folder and drag it to your 
Dock. Then, open it. The first thing you 
want to do is set your preferences. Go to the 
Dictionary menu, and select Preferences.

In the Preferences window, select the 
tools you want to use.  Diane uses New 
Oxford American Dictionary, Apple Dic-
tionary, New Oxford Thesaurus, Oxford 
(British) Dictionary, Oxford (British) 
Thesaurus and Wikipedia. 

You can put the tools in the order you 
want them to appear in by sliding them up 
and down. Once you close Preferences, 
they’ll appear on the bar of  the Dictionary 
and you can choose to use all, or select the 
individual references. 

How many times have you looked up a 
word and found it was full of  words that 
you didn’t know the meaning of. If  that 
happens in Dictionary, you can hover over 
the word, then click it and it will take you 
to the definition of  that word. Use the 
orange arrow to return to where you were.

The Dictionary is a great grammar tool 
as well.  From the Go menu, select Front/
Back Matter.  It opens the Table of  Contents 

Sweet Tips and Tricks
continued from page five

and Index for the New Oxford American 
Dictionary.  Scroll down to Ready Refer-
ence, then Language Guide, then Rules of  
English: Understanding Grammar. NOTE: 
It puts Front/Back Matter in a Spotlight 
window. To close Front/Back Matter, de-
lete it from the Spotlight window.
More Dictionary and Spelling Checks

If  you Control Click over words in appli-
cations in which you create text—Microsoft 
Word, Pages, Keynote, even Mail—it lets 
you choose to define, find a synonym, 
translate, or Web search in a Reference 
Tools window. (In Pages and Keynote it 
is limited to a dictionary and thesaurus.)

If  you are in Microsoft Word and a word 
turns up with a red line under it indicating 
a possible spelling error, you’ll notice that 
the little book on the bottom of  the window 
has changed from a pencil to a red X.  If  
you click on the red X, it asks if  you want 
to check the spelling and gives you options 
for what word you might have meant to 
type.  Or, you can just Control-Click on 
the underlined word.
Foreign Punctuation

Accents marks on your computer and 
your iPhone work in Word, Pages, Key-
note, and Mail, and others. There are 2 
ways to do it:

1. On the computer: Option + most of  
these letters will give you the most com-
monly used accent for that letter. Then you 
actually have to type the letter again, not 
holding the option key to get the accent 
mark on top of  the desired letter.

2. Easier is to hold down the key for a 
moment longer than usual and a small 
window will open above the letter showing 
the accent options. You can either use your 
cursor to select the one you want or you 
can type the number that appears below 
the accent you want. (Sue notes: this might 
only work in Lion and Mountain Lion. I does 
not work in Snow Leopard.)

This works great on the iPad or iPhone. 
iPhone: Pull out your phone and try it. 
Hold the desired key a little longer than 
normal and the options appear.
Grab, it’s the new Screen Shot!

Grab, another Application on your Mac, 
works similar to the command-shift-3 and 
command-shift-4 screen shots that Karen 
showed, but it leaves the image on the 
screen for you. Diane says, “When I’m 
looking up information that I want to refer 
to easily, I leave the image and go back 

continued on page seven
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All Keys

Multimedia Integration
(AppleTV, Music, Movies
and Photos)

Service, Support and
Education Specialists

Mobile Computing Services  
We Come To You!







Attention Friends of Abby!
Abby Bellard, who has been so useful 
and wonderful to UKMUG since she 
arrived in the Keys last year, had to 
pack up and move back up north to 
tend to a family emergency. Those 
of you who are her clients probably 
already know this. She will be staying 
in touch with her students. We wish 
Abby and her husband Tim the best 
and hope that they will be able to 
return to the Keys soon!

and forth between my application and the 
Grabbed image.  I can also minimize it to 
have it in easy reach but out of  my way 
on the screen.”

If  you want to put it in iPhoto, you 
should save it in Grab, then drag it from 
the Finder Window into iPhoto.
Speech and Listening

Your computer has a voice and is a good 
listener (okay, sometimes it listens), and 
your iPhone isn’t the only one who talks!

The computer will read text that you 
highlight if  you press Option + Esc. Here’s 
how you set it up:

-- Open System Preferences
-- Look for the Speech Icon in the row 

marked System
-- Click Text To Speech
-- Choose the System Voice and Speaking 

Rate (have fun listening to the choices!)
-- Click “Speak selected text when the key 

is pressed.” The default key is Option 
+ Escape, but you can change it.

While you are there, click on Speech 
Recognition. 

-- Speakable Items On
-- Command: Select a Command Set. 

Check them all!

Under “Configure” it opens your Ad-
dress Book.  Makes the addresses speak-
able. (They should all already be selected.)

Look at Helpful Tips to see you how to 
make the Speech Commands work better.

Under Settings: Here you set it to Inter-
nal Microphone (unless you want to use 
a external microphone, then it’s Line In).  
Calibrate helps the system learn your voice.  
The Default Listening Key is Escape.

Listening Method. Di chose “Listen only 
while key is pressed.” Otherwise, you have 
to teach the system a word and  then when 
it hears that word, it follows your verbal 
commands.

If  you want it to acknowledge that it has 

Sweet Tips and Tricks
continued from page six

understood your verbal command, check 
the “Speak command acknowledgement” 
box.  And then select the sound you want 
to hear when it performs the command 
under “Play this sound.”

When you close System Preferences, 
you’ll note that a small round icon appears 
on your desktop. It’s called the Feedback 
Window. It has two func-
tions. First, it shows you 
what your voice level is 
as you speak. Second, it 
lets you easily access the 
Speech Preferences and 
the Speech Commands Window. 

Once you’ve set it up in System Pref-
erences, your computer will also follow 
verbal commands. Press Esc and, using 
your verbal commands, ask it to do things 
like: Switch to Calculator, Switch from 
System Preferences, Insert Today’s Date, 
Paste the clipboard here and Mail to [name 
someone].

You can have a lot of  fun playing around 
with this one. The best is “Tell me a joke.”

And that, folks, is finally the end of  the sweet 
tips we got that night!! Thank you Karen, John 
and Di for so much great information!

 

The Future is Here
from Karen Beal

30 years - doesn’t seem so long ago but 
just LOOK at the technology back then!

http://www.youtube.com/watch?v=5
WCTn4FljUQ&feature=youtu.be

 MAC FOR SALE

I have an 8 core Mac pro for sale in case 
you hear of  anyone in need. 8 core 8 gigs 
ram. bent case. $650. Contact Jack at All 
Keys Computer Guy----see ad at right.

dummies.com 
is a great place for
 useful and brief          

Mac Tips and Tricks! 
Check it out!
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Macintosh Systems Solutions
Key West Courses: March 2013.
----------------------------------------------------------------
Saturday, March 9th, 10-11AM
Introduction to iPad 
Free:  REGISTRATION REQUIRED
Discover and explore iPad -- from settings, or-
ganizing, and multitasking to surfing the web, 
checking email, watching movies, listening to 
music, reading books, and more. See how easy 
it is to shoot HD video and take playful photos 
in PhotoBooth. Learn about a few of  the thou-
sands of  apps from the App Store.
----------------------------------------------------------------
Saturday, March 16th, 10-11 AM
iMovie ‘11 Essentials
Free : No registration required
With iMovie ‘11, playing with video is now as 
easy as playing with photos. iMovie ‘11 creates 
a library of  all your video clips, new and old, 
so you can browse through them anytime. 
Want to make a new movie in no time, com-
plete with music, titles, and dazzling transi-
tions? Drag, drop, done. Refine every shot 
with the Precision Editor, enhance your movie 
with new titles, transitions, and effects -- then 
share your movie directly through YouTube, 
Facebook, or Vimeo.
----------------------------------------------------------------
Saturday, March 23th, 10-11 AM
iTunes 11 Essentials
Free : No registration required
iTunes lets you organize and play digital music 
and video on your Mac. And it’s a store that 
has everything you need to be entertained. 
In this course, we’ll show you how to import 
music, organize your iTunes library, purchase 
and rent media from the iTunes Store, and 
how iTunes can be the perfect DJ or music 
entertainment for your party.
---------------------------------------------------------------
For more information, stop by the store or call us 
at 305-293-1888. Macintosh Systems Solutions. 
1001 Truman Avenue @ Grinnell Street, Key 
West, FL. Apple Authorized Sales, Service, and 
Training. Right here in the Keys. Cool.

Rest in                        
Peace,                            
Dave                       
Game!

      by Sue Beal

In the mid-90s, Apple required every user 
group to have a website in order to keep 
their user group affiliation. We didn’t have 
anyone in UKMUG capable of  making a 
site, and Dave Game (a member of  Gold 
Coat Mac, our neighboring user group in 
Miami) volunteered, designing and imple-
menting our site at UKMUG.org. The site 
is still pretty much as he designed it. (I 
maintain our PB Wiki site, which is easy 
enough even for me to do, so it’s more up 
to date.)  I just learned of  Dave’s passing:

MIAMI (CBS4) – Dave Game, a long-
time member of  the WFOR/CBS4 news 
family, passed away after a long illness 
on February 5, 2013. A veteran journalist 
with nearly four decades of  experience in 
television, radio, and new media, he most 
recently managed South Florida internet 
operations for CBS, a position that found 
him playing a vital role in growing CBS 
South Florida internet properties to a 
dominant position.

In 1974, Mr. Game started his career 
in radio at age 18 by supervising the con-

struction and FCC licensing process of  a 
radio station for his college. After leaving 
college he spent a few years in commercial 
radio, first as a personality and later as 
News Director.

Two years later, he moved to television 
as a reporter and later an anchor in Elmira, 
New York, Huntsville, Alabama, Nashville, 
Tennessee and Detroit, Michigan. In 1985, 
he moved to WCIX (now WFOR) in Mi-
ami, where he served as an award-winning 
general assignment reporter, investigative 
reporter, and Emmy-award-winning inves-
tigative producer before making the move 
to new media in 1995.

Dave helped create WFOR’s website, 
one of  the first broadcast websites in South 
Florida. In 2005, he moved to new media 
full-time, as Executive Producer for Digital 
Media for CBS stations in South Florida. 
He supervised a staff  of  six providingupdat-
ed news and information virtually around 
the clock seven days a week for cbsmiami.
com, and through his leadership, it became 
one of  the most highly ranked broadcast 
websites in South Florida.

Dave garnered numerous professional 
awards. In 2001, he was honored with the 
Silver Circle by the National Academy 
of Television Arts and Sciences Suncoast 
Chapter for 25 years of service to Television.

h t t p : / / m i a m i . c b s l o c a l .
com/2013/02/06/longtime-cbs-miami-
web-producer-dave-game-dies-at-57/

UKMUG 2012 Financial Statement

THANK YOU JOHN THOMAS- TREASURER
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1.  Password Protect Your Devices

Choosing not to password protect your 
devices is the digital equivalent of  leav-
ing your home or car unlocked. If  you’re 
lucky, no one will take advantage of  the 
access. Or maybe the contents will be 
ravaged and your favorite speakers and/
or secrets stolen.        
2.  Put A Google Alert On Your Name

This is an incredibly easy way to stay on 
top of  what’s being said about you online. 
It takes less than a minute to do. Go here: 
http://www.google.com/alerts and enter 
your name, and variations of  your name, 
with quotation marks around it. Boom. 
You’re done.
3.  Sign Out Of Your Online Accounts 
When You’re Finished Using Them

Not only will this slightly reduce the 
amount of  tracking of  you as you surf  the 
Web, this prevents someone who later sits 
down at your computer from loading one of  
these up and getting snoopy. If  you’re using 
someone else’s or a public computer, this is 
especially important. Yes, people actually 
forget to do this, with terrible outcomes.        

10 Incredibly Simple Things You Can Do To Protect Your Privacy 
submitted by Diane Marshall; from http://www.forbes.com/pictures/edej45ejghf/password-protect-your-devices-7/

if  someone gets your password somehow, 
they won’t be able to use it to sign into your 
account from a strange computer. Google 
says that millions of  people use this tool, 
and that “thousands more enroll each day.” 
Be one of  those people.         
7.  Pay Cash For Embarrassing Items

Don’t want a purchase to be easily tracked 
back to you? You’ve seen the movies! Use 
cash. One data mining CEO says this is 
how he pays for hamburgers and junk food 
these days.        
8.  Change Your Facebook Settings To 
“Friends Only”

Visit your Facebook privacy settings. 
Make sure this “default privacy”setting isn’t 
set to public, and if  it’s set to “Custom,” 
make sure you know and are comfortable 
with any “Networks” you’re sharing with.        
9.  Clear Your Browser History And 
Cookies On A Regular Basis

When’s the last time you did that? If  
you just shrugged, consider changing your 
browser settings so that this is automatically 
cleared every session. Go to the “privacy” 
setting in your Browser’s “Options.” Tell 
it to “never remember your history.” This 
will reduce the amount you’re tracked 
online. Consider a browser add-on like 
TACO to further reduce tracking of  your 
online behavior.
10.  Use An IP Masker

To hide your online footprint, you can 
download Tor or use an easy browser-based 
option like HideMyAss.com.

4.  Don’t Give Out Your Email, Phone 
Number, Or Zip Code When Asked

Obviously, if  a sketchy dude in a bar 
asks for your phone number, you say no. 
But when the asker is a uniform-wearing 
employee at Best Buy, many a consumer 
hands over their digits when asked. Stores 
often use this info to help profile you and 
your purchase. You can say no. If  you feel 
badly about it, just pretend the employee 
is the sketchy dude in the bar.        
5.  Encrypt Your Computer

Encrypting your computer means that 
someone has to have your password (or 
encryption key) in order to peek at its 
contents should they get access to your 
hard drive. On a Mac, you just go to your 
settings, choose “Security and Privacy,” go 
to “FileVault,” choose the “Turn on Fil-
eVault” option. Boom goes the encryption 
dynamite. PC folk need to use Bitlocker.        
6.  Turn On 2-step Authentication In Gmail

This simple little step turns your phone 
into a security fob - in order for your Gmail 
account to be accessed from a new device, 
a person (hopefully you) needs a code that’s 
sent to your phone. This means that even 

AnaGrahams
from Graham Thomas

I was browsing an anagram site and 
came across these which apply to Apple:

Apple Products = Support Placed  

ipod lover = poor devil 

Apple, Inc = Epic Plan 

The Apple Macintosh = Machines apt 
to help

I particularly like the ipod lover! —Graham

This free eBook is full of  tips and tricks 
you’ll benefit from for years to come!

Did you know you can add your own 
keyboard shortcuts on the iPad or iPhone? 
How about some faster ways to reject sug-
gested auto-corrections as you type, or 
write contractions, or a single-tap method 
to magnify and select text? This free eBook 
from Michele Ballard is jammed full of  
handy, cool techniques like these.

I recently downloaded this book from the 
iBooks Store and was so impressed by the 
first few tips alone that I knew I had to share 
it here. Most of these tips will work on the 
iPad too. Tips are organized into sections like 

“Keyboard and 
Writing Tips”, 
“Mail and Calen-
dar”, and so on.

Get this won-
derfully useful free iBook 
here:  ht tps ://i tunes.
apple.com/ie/app/154-
br i l l iant - iphone- t ips/
id540225948?mt=8.

Note that some of  these techniques may 
only be available with more recent versions 
of  iOS (like 5 and later), so if  you are well 
out of  date, some of  these may not work 
on your device.

Free eBook: 154 Brilliant iPhone     
(and iPad) Tips            by K. Walsh 
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Come at
6:30 for the

Beginners Circle:
Bring your laptop 

and your questions 
at 6:30, and for a half-hour
prior to the main meeting 

we'll have experienced 
folks available to help, 

one on one, or in 
small groups.

FREE CLASSES IN KEY WEST!
Macintosh™ Systems Solutions has a free class 

almost every Saturday morning at the store in Key 
West! Visit them at 1001 Truman Avenue at the cor-
ner of  Grinnell. They offer a wide range of  classes 
for new and experienced Mac users. Stop by for all 
your Apple sales, service, and training needs, or call 
293-1888.

Did you see that picture         
of you, taken at the last 

meeting? 

http://ukmug.pbworks.com/

Color Copies •  Large or Small Orders
Rack Cards • Business Forms & Checks • Brochures

Business Cards • Letterhead • Envelopes

Signs and Banners • Multi-Part Forms • RX pads 

Posters • Rubber Stamps • Graphic Design

305-664-1002 
81933 Overseas Hwy., Islamorada

printsourcekeys@yahoo.com

The Official Newsletter of the Upper Keys Macintosh Users Group August 1993                   Volume 1, Issue 1

is the official newsletter of the

Upper Keys Mac Users Group
A nonprofit organization devoted to the use (and 
sometimes abuse) of the Macintosh computer. 
Subscriptions are $25.00 for one year. Contents © 
1993 - 2013 by the Upper Keys Macintosh Users 
Group except where noted. All other rights reserved. 

219 Second St. • Key Largo FL 33037
(305) 451-4601 • ukmug@bellsouth.net

Share! Send us your stuff!

VISIT TODAY!
http://ukmug.pbworks.com/ Monroe County Recycling

 Collection Center: MM 100.1 
Oceanside (Magnolia St.) 

453-0788

E-RECYCLING: 2nd & 4th Wed. 
every month, 10am - 2pm 

E-waste: Monitors & Computers
 Batteries, Televisions, All Telephones
& FAX Machines, Printers / Copiers, 

DVD / VCR Players, Radios & 
Speakers, Discs & Cassettes 

Also taking Hazardous Household Waste.

Special Saturday E-waste Collections 
throughout the Keys in March:


